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Writing Research Papers

Many courses at SCC require students to write research essays. These assignments ask students
to research published information to help them not only expand their understanding and view
of the topic, but also to provide evidence of critical thinking. The most important thing to
remember is that a research paper is not a pasting together of other people’s writing, but rather
a compilation and discussion of a student’s own ideas, supported by other sources. Reliable,
published sources lend credibility to writing and are a great way to support a writer’s ideas.
However, it is important to remember that whenever you gather information from any source,
you will need two things: a proper citation at the end of the sentence containing the quotation
or paraphrase, and also a corresponding entry in your Works Cited page. See the section “Using

In-text Citations” for more details and specific situations.
General Advice as You Begin

e Start early. Even though the final paper’s due date may seem far away, the research,
drafting, and revision process demands much time. Anticipate possible problems and
setbacks by beginning early.

e Be organized. Keep track of everything—this will save you time and work later on in the
project. Many students organize with large file folders to. Record the title of books,
magazines, journals, authors, and page numbers in one place. On your personal
computer, create a folder to bookmark Internet sources and a file to store any articles
that you have downloaded. You may also want to photocopy articles and print Web
sources. Keep track of where you found the sources that you reviewed. If you decide
later that you want to take a second look at a source that, your notes or files will make it
much easier to find the source.

e Set personal deadlines. Even if your instructor does not assign “benchmark” deadlines
for research and drafts, that does not mean that you cannot set your own. Create
deadlines on an academic calendar, spreading them out enough so that you can
realistically meet the deadlines. Some students find it useful to post these dates on a
note that is visible to them every day—a small note on a computer screen or a door.

e Ask questions. If you are confused about the assignment in any way or are unsure of
your topic or thesis statement, ask your instructor. Meet with your instructor during his

or her posted office hours, or schedule an appointment, to discuss your project.



Create a weekly writing schedule. It is useful to schedule a time to work in the library
or at home. Build your project into your weekly schedule. If you have a half-hour
between classes or before work, research online or work on the Works Cited page, or
submit your paper to Smarthinking.

Visit the Writing Center throughout the writing process. If you live in or near Lincoln,
visit the Writing Center as often as you can with revised drafts. You can either visit the
Center in person or upload your file to Smarthinking.com, an on-line tutoring service
available to SCC students free of charge. Smarthinking is particularly helpful if you do
not live in Lincoln or if you are an online student. The Writing Center is open Monday
through Friday, and it is located in the lower section of the Learning Resource Center
(LRC) at the 8800 ‘O’ St. SCC campus. Call the Writing Center at (402) 437-2627 for
current hours, to ask a brief writing question, or to make an appointment. You may
walk in or schedule an appointment. Tutoring is now available by appointment at ESQ.
See our web page for more information. All services are free to current SCC students.
Please bring a current SCC student ID. Tutors help students at all stages of the writing
process—from choosing a topic or research question to polishing a final draft, whether

in person or on Smarthinking.com.

To submit your essay on Smarthinking.com for an electronic tutorial:

Save your file in Rich Text Format (RTF), remove any graphics or illustrations, and log
onto www.smarthinking.com (Note: the address has only one “t”).
Username: Type SCC and hyphen + your first name initial + last name initial + your SCC
id number. Use lower case.

=  Example: Roger Brown student id number 353553. Username: SCC-rb353553
Password: southeast
Tutors will read your work (usually within 48 hours) and return the draft with a report.
Feel free to call or drop by the Writing Center if you have questions about
Smarthinking.com or your report from Smarthinking.
For log-in problems, students, not their teachers, should call 402-437-2627. The staff at
the Writing Center can help students with most log-in problems, but will need to talk
directly to the student.
Whether you see a tutor in the center or use Smarthinking, visit or submit your essay at

least five days before it is due to allow you time to use what you learned from your



tutor and revise your paper. Note that Smarthinking can take up to 48 hours for a

response to your essay.

Formulating the Research Question

Beginning the research stage can be a daunting experience. Be sure to discuss any questions
you may have about your topic with your instructor early in the process. He or she may have
valuable suggestions about possible sources or databases that maybe useful (which may save
you time, too!). Also, your instructor may give you feedback about your topic’s focus. If you are
assigned a seven-page research essay on Mark Twain, for example, you will need a focused
research question to guide your research. In this case, the topic of “Mark Twain” is too broad
unless you are writing a book about his life. Make sure that your topic’s focus falls in line with
the assigned page-length. Count on the general rule that the shorter the essay length, the more

focused your question should be.

Focusing your research question will also help you narrow your research. If the topic were the
role of Mark Twain’s experience navigating the Mississippi River and the way it may have
influenced his writing of The Adventures of Huckleberry Finn, then the project becomes much
more grounded, and you can immediately construct a list of useful sources that would narrow

the project from a broad, general search of thousands of references to a much smaller list.

Mark Twain

-

L _/

The Adventures of Huckleberry Finn
Mark Twain worked on a river boat
The river figures heavily in the novel

]

Focused research question: How did Mark
Twain's riverboat experiences influence The
More Focus Adventures of Huckleberry Finn?
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Gathering Research

Once you have a focused research question, it’s time to begin researching. There are a number
of places to start:

e Internet searches (see discussion of academic Internet sources)

e Llibrary databases

e Traditional sources: books/magazines/newspapers
Give yourself enough time to visit the library in search of information on your topic. While
there are many reliable sources that you can access electronically, libraries still contain endless
materials that are not available through a general Internet search. SCC students have borrowing
privileges at the SCC Library (LRC). In addition, with your SCC ID or a Nebraska driver’s license,

you have privileges at the University of Nebraska-Lincoln’s Love Library (http://iris.unl.edu).

Also, check your city library for borrowing policies. Talk to the reference librarians about your
paper and ask for suggestions. SCC'’s library has excellent reference librarians available to
answer questions about your research. Be sure to follow the advice mentioned earlier about

organizing your research.
Evaluating Sources

When reviewing the possible sources for your paper, consider reliability and acceptability. Just
because something was published doesn’t make it a reliable, truthful, or up-to-date source.
Anyone can publish, so use critical thinking when evaluating and selecting any type of source,
whether online or in print. If you are writing about a medical issue, for example, a book
published in 1962 is probably less credible than one published this month. If a source is
published by Harvard University Press, it is more likely to have been reviewed by credible

leaders in the field than a book published on an individual’s homepage.
Reviewing Sources: Frequently Asked Questions

What types of sources are the best to use?
Scholarly journals published by universities, research institutions, and professional
organizations tend to be more credible than popular magazines (Ormondroyd). Journals
list the sources used in their articles, which you may want to find and read for your own
research. In addition, books published by universities or well-known presses are usually
credible because they are more likely to be carefully scrutinized by a professional review

committee prior to publication.


http://iris.unl.edu/

What do | need to know about the author?
Sometimes the author may be an organization, such as the American Heart Association.
Many times, the author is an individual or group of individuals. To evaluate the author’s
reliability, read the author’s credentials, such as degrees, professional memberships or
associations, and other publications, occupation, or research experience (Ormondroyd).
What'’s so important about the date of publication?
The information on many topics, such as medicine or technology, changes rapidly. For
comprehensive, credible research, avoid using outdated sources (Ormondroyd). Ask
your instructor for guidelines to publication dates regarding your topic.
What type of sources should | avoid?
Beware of writing that contains logic errors, propaganda, and unsupported opinions.
Look for comprehensive, well-researched, objective writing. Ask yourself if the facts are
verifiable and based on sufficient evidence. Carefully review any ideas that radically
vary from other sources on the same topic (Ormondroyd).
What about blogs, Wikipedia, Twitter, etc.?
Many high-profile blogs are becoming more accepted as valid sources. When citing a
blog entry, it is critical to know the author and his or her credentials and then evaluate
the quality of the source. If the source is valid, make sure you build this credibility into
the set up for your discussion of this writer. For instance:
Many bloggers suchas _____, who is a law professor writing the professional
blog, __, have suggested that the law should be repealed. “Quote what this
blogger said here,” said .
Most entries in Wikipedia can be edited by anyone, so again pay close attention to who
you are quoting and his/her credentials. On the other hand, many of the entries list
sources that you might find useful and reliable.
More educational and professional organizations are publishing on sites such as Twitter.
Search the web for “Top 100 Edu Tweeters” to read about what is available.
Carefully review the section here on “Evaluating Sources,” and apply these principles to

all of your online research.

Again, when in doubt, ask your instructor if blogs, Wiki’s, or Twitter are an

acceptable forms of support in your specific writing assignment.



Are Web pages and online library sources the same thing?
No. Libraries subscribe to services that provide previously published articles online.
These online databases, such as First Search and EBSCO, provide electronic versions of
scholarly journals and articles. Web search results from Google and other search
engines should be scrutinized much more closely than library print articles or online
database articles. Unless your instructor asks you to do so, you should never rely solely
on general Webpage sources, and in most cases these types of sources should be
avoided. However, Google now offers a feature called Google Scholar, which offers

academic articles, books, law briefs, etc.

Is the Web page I’'m using credible?
Proceed with caution. A page is credible if it is associated with a known, reliable
organization, such as a national association or university (look for .edu, .gov, or .org at
the end of the Web address). To find out, look at the URL (Internet address) for a link to
a homepage. However, be wary of classroom pages. While these may be associated
with a university, the essays are often written by other students who are just beginning
to learn about their topics. Avoid using these, but take advantage of their Works Cited

lists, which may include or even link you to valuable sources that you can use.



Avoiding Plagiarism

What is Plagiarism?

Plagiarism is taking personal credit for someone else’s ideas or work. The MLA Handbook
defines plagiarism as intellectual fraud, which is “using another person’s ideas, information, or
expressions without acknowledging that person’s work” (2.1). It further states: “Passing off
another person’s ideas, information, or expressions as your own to get a better grade or gain
some other advantage constitutes fraud” (2.1). Search the Internet for Simon Fraser’s

“Plagiarism Pretest.” You will be surprised by many of the answers.

Types of Plagiarism

Plagiarism comes in many forms. Sometimes it’s deliberate, and sometimes it’s accidental.
Sometimes students don’t take good notes about their sources, or they forget to give credit to a
citation. Many plagiarism-related mistakes occur because students are unaware of the rules or

misunderstand the terminology associated with writing and plagiarism.

Even accidental plagiarism
can have serious
consequences.

— =

Most simply, if you hear or read something and put the words or ideas in your paper, you must

cite it. Sometimes students will deliberately retype a published article or copy an article from
the Internet and pass it off as their own work. Others do the same, but copy and paste several
sources together and call it their own. These are examples of plagiarism, and in either case, the
student could fail the class or be dismissed from the college. (Students should be familiar with
SCC’s policy on plagiarism.) It’s important to remember that just as technology has made it
easier for students to buy or copy papers from the Internet, technology has made it equally
simple for instructors to detect plagiarism. Most instructors are skilled at identifying plagiarism
and locating the original source. If you are tempted to plagiarize because you are unable to

handle your workload, don’t. Talk to your instructor and let her know that you want to do a



good job on your paper and discuss any possible arrangements, such as turning in the essay
late for a point deduction, or even extending the deadline (this is entirely up to your

instructor’s discretion).

Southeast Community College Policy on Plagiarism and Academic

Dishonesty

The SCC pamphlet on Academic Integrity (available from the Dean of Student Services) states,
“Cheating, plagiarizing, or fabricating research are particularly reprehensible in a community
dedicated to the advancement and pursuit of knowledge.” It goes on to provide some examples
of academic dishonesty:
e Cheating: using or attempting to use unauthorized materials for one’s own
academic benefit.
e Plagiarism: intentionally [or unintentionally] presenting as one’s own work the
ideas, words, or information of another without citing the reference.
e Fabrication/Falsification: inventing or knowingly altering information.
e Facilitating Academic Misconduct: assisting another individual in committing actions
considered academically dishonest. (Academic Integrity)
“Violation of this policy will be reported to Student Services and may result in the following
sanctions:”
e agrade of “U” (unsatisfactory) for the exam, paper, or course.
e disciplinary warning or probations notice.
e Suspension.
e expulsion. (Academic Integrity)
Also note that reusing a paper which you wrote yourself in another class is considered academic

dishonesty. Be sure to discuss any questions about this with your instructor.

A Note on Plagiarism and the Internet

Students can find sites that aid in cheating and provide downloadable essays on the Internet. If
you search for “free essays,” you will receive thousands of pages that offer pre-written essays
on almost any subject imaginable. However, copying whole essays or pasting together passages
of essays is plagiarism. Clearly, if this guide tells you how cheating can be done, then
educators are well aware that some students make use of these sites. It’s very easy to do, and

some students tend to do it when they are feeling stressed about getting all of their work done

10



or feel concerned about grades. Chances are, students who plagiarize will get caught, and this
will only heighten the anxiety about passing the course. SCC’s faculty is very serious about
plagiarism, so students should familiarize themselves with SCC’s policy on plagiarism. Bottom

line: Don’t do it.

To enable students to check for plagiarism, SCC subscribes to Turnitin.com, which helps detect
some types of plagiarism errors in student work. To use Turnitin.com, ask your instructor for an
access code. Your instructor may also require you to use Turnitin.com for your assignments
and/or check your papers him/herself. However, you will gain a great deal from reviewing your
papers for plagiarism before you turn them in. If you need help, you can always visit the Writing

Center.

Tools to Avoid Plagiarism

The first step to avoiding plagiarism is familiarizing yourself with some of the basic terms
associated with writing and plagiarism. Learning to properly use direct quotes, paraphrasing,
summarizing, parenthetical citations, and the Works Cited page provides the best tools for

ultimately avoiding plagiarism.

e Direct Quotes: A direct quote is a word-for-word replication of something someone has
written or said. Direct quotes are indicated by quotation marks. When using a direct

qguote, be sure to copy every word exactly as it was said or written. After each direct

qguote, use a parenthetical citation. See “Using In-Text Citations.”

e Paraphrasing and Summarizing: The difference between paraphrasing and summarizing
is subtle, and the words are often used interchangeably. Paraphrasing entails taking
something that someone else said or wrote and putting it into your own words. The
Online Writing Lab (OWL) at Purdue University explains paraphrasing as “putting a
passage from source material into your own words. . . . Paraphrased material is usually
shorter than the original passage, taking a somewhat broader segment of the source
and condensing it slightly” (“Quoting”). Paraphrasing provides an excellent way to
restate your source’s ideas in a style and language that fits your writing style and
intended audience. Summarizing, on the other hand, concentrates only on the main
points of a source. OWL explains summarizing as “putting the main idea(s) into your

own words, including only the main point(s)” (“Quoting”). The definitions of

11



paraphrasing and summarizing may seem to have little difference, but you must

approach both in the same way: if you didn’t originally think of the idea, no matter how

much you rephrased it, cite it!

It is also important to note that changing one or two words of a sentence

is not sufficient enough to count as “putting it into your own words.”

Writers must significantly alter the construction of the sentence when

summarizing and paraphrasing.

Parenthetical Citation: A parenthetical citation is the information in parentheses foun

d

at the end of a sentence where outside sources were used. The citation tells the reader

about the source that was used. It includes information about the author and what
page(s) the information can be found on. There are different ways to cite different

sources, so rely on this guide and the MLA Handbook for proper procedures.

Works Cited: The Works Cited page is an alphabetical listing of all the sources used
(cited) in a paper. MLA Style has detailed rules regarding how various types of entries
are recorded and what type of information is required. Spend plenty of time with this

guide and the MLA Handbook to learn how to create the Works Cited page.

12



Introduction to MLA

The Southeast Community College Writing Center has compiled this guide to provide a general,
easy-to-use reference for what is required in an MLA style essay. The most inclusive source for
MLA style questions is the current edition of the MLA Handbook for Writing of Research Papers,
seventh edition, but this guide is a useful starting point for students completing academic
writing that requires the use of MLA style. The SCC Writing Center also provides shorter hand-
outs for various aspects of using sources and a Power Point presentation demonstrating MLA.
Please stop by the center or check our web page, which is located on the student links page at

my.southeast.edu.

Although MLA style is widely known and used on a scholarly level, other formatting styles exist.
It is important to realize that MLA style is not the style for college and academic writing, but that
there are other styles used for various other college departments and courses:

e MLA style is often associated with English and other Humanities classes.

e Social Science courses require the use of the American Psychological Association’s APA

style.

e History may require the Chicago Manual of Style.

e Your instructor may give you specific instructions on how to cite your sources.
Whatever method your instructor assigns, it is important to be as careful as possible to be
accurate and detailed in applying the style to your academic papers. As you will see with MLA

style, the placement of periods, commas, and colons all count.

13



Using In-text Citations

Framing Quotes and Paraphrases
You can incorporate outside information into your papers through several different methods. In
this section, you will learn how to use direct quotes and paraphrasing to integrate useful

information into your writing and how to correctly cite the information you use.

The following examples demonstrate many ways to show your reader that the information in
your writing comes from an outside source:

Signal phrase (See MLA 6.3 and/or The Everyday Writer sec. 48):

e If youintroduce your quote with a signal phrase, it alerts your reader that it is no
longer you talking, but a source. For example:
According to Jane Smith,
Jane Smith argues,
e Your signal phrase can also include information about the author:
Jane Smith, professor of English at UNL, explains,

e If your source does not contain the name of the author, use the title of the article
instead (do not use the name of the journal, newspaper, Website, URL, etc.).
Afterward, you can refer to the writer as “the author” as long as it is clear to your
readers which source you mean:

According to “No Time for Play,”

The author argues,

14



End Tag:

One source found that,
When using a signal phrase, place the page number where the material can be
found in parentheses at the end of the sentence. (See MLA 6.3).

According to Jane Smith, English is an immersive field of study (64).

As explained by Jones, “Cats are better than dogs” (103).

While the examples above (called “framing”) are the clearest ways to introduce a
guote, sometimes the signal phrase is difficult to work into the wording of your
writing. In such a case, you can cite the source without a signal phrase by placing
the author’s last name and the page number in parentheses at the end of the
sentence:

English is a very immersive field of study (Smith 64).

The study found that “cats are better than dogs” (Jones 103).

NOTE: There is no period after the last word of a sentence with a parenthetical citation (unless

it is a quote over three lines long and blocked). The period always finishes the sentence. Also,

note that MLA style does not use a comma after the author or “p.” for page numbers.

(p. 23)
(Smith, 23)

Tips for Paraphrasing and Balancing Research

Use paraphrasing whenever you can. Your writing will be clearer if you paraphrase
your sources instead of forcing another’s writing style to fit into your style.

Never write an entire paragraph containing only your source’s ideas. You must
always interpret your reference’s ideas and explain how they support your thesis.
Always begin and end a paragraph with your own ideas; otherwise, you lose your
voice and credibility, and you will not have a transition between paragraph ideas.
Always make your own ideas the majority of your essay. Think of quotes and
paraphrases as extra information that helps build your own ideas.

See the following table for words you can use for signal phrases. Remember to only
use a signal phrase that fits with the context of your essay; for example, do not

write “Smith argues” if Smith is not arguing a point.

15



Sample Signal Phrases:

according to
advises

argues that

as explained by

as reported by
believes
demonstrates that
discovered that
emphasizes

explains

finds that
illustrates
instructs
observes
points out
presents
recommends
relates that
reports that

reveals that

says
shows
suggests
states that
warns

writes

16



Quoting and Paraphrasing example:

The following paragraph comes from an article titled “Shenandoah National Park: A
Land Reform,” written by T. Edward Nickens and published on pages 64-66 of the June

1999 issues of Backpacker. This particular passage occurs on page 64:

And happily for hikers, most of the park’s visitors are content with a meager
glimpse, one that comes from behind a windshield or from a scenic outlook.
The 105 mile Skyline Drive scenic byway runs along the crest of the Blue Ridge
through Shenandoah and draws heavy traffic in spring and fall. Most of these
visitors head for the closest picnic table, if they bother to leave their cars, or

drive the posted speed limit and see the park in a mere three hours.
The following examples are incorrect. See if you can figure out why.

e Hikers are lucky that much of the park’s visitors are happy with a quick look, one
from inside of the car or a short look a few feet from the car on a scenic
overlook. The 105 mile road follows the ridge of the Blue Ridge to Shenandoah,
which attracts many visitors in spring and fall. The majority of the visitors make
a bee-line for the nearest picnic table or never get out of their cars at all. They
keep to the speed limit and can see the park in just three hours.

[Why it’s wrong: Notice that the writer follows the original pattern of the
writing, changing a word here or there. Either put it all in your own words or
quote it word for word and add quotation marks. Also, the passage must end

with a citation].

e Hikers are happy that “most of the park’s visitors are content with a meager
glimpse,” coming from inside of the car or a quick look a few feet from the car
on a scenic overlook.

[Why it’s wrong: needs a citation].

e According to T. Edward Nickens, hikers are lucky that much of the park’s visitors
are happy with a quick look, one from the inside of the car or a quick look a few
feet from the car on a scenic overlook.

[Why it’'s wrong: While the writer mentions the name of the source, the

paraphrase is too close to the original phrasing, and it still needs a citation].
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Here is an example of how to integrate summary and direct quotes into your essay:

Many people today are missing sights seen by hikers,
backpackers, and bicyclists who are attracted to scenes
that can only be viewed if they leave the roads.
According to T. Edward Nickens, visitors to Shenandoah
State Park limit their view of the park to what can be
seen from a car (640). These folks miss the incredible
flora and fauna found beyond their view deep in the
woods where nature avoids the sounds of our
industrialized society. Nickens explains that, “Most of
these visitors head for the closest picnic table, if they
bother to leave their cars, or drive the posted speed
limit and see the park in three hours” (64). Like Nickens’
example of the Shenandoah State Park, we can find
dozens of similar scenes in national parks across
America where people limit their view of nature to that
seen in the park’s information centers or by listening to
a CD while driving the designated route. Perhaps if
more people stepped out of the car and off the
concrete, more people would be concerned with the
devastation happening to the dwindling acres of

wilderness scattered throughout this country.

Notice that the
paragraph starts out with
the student’s own ideas.

Here the introductory
phrase is followed by a
paraphrase and then the
citation.

Here is a direct
guotation, again using
the framing device, but
this time we know from
the quotation marks that
these are the author’s
exact words.

o R o |

Here the writer
compares what Nickens
said with his/her own
observations. This makes
a nice transition into the
final sentence. Not only
does the student avoid
simply summarizing an
article about hiking, but
he/she is using sources
about hiking to set up a
point about the
devastated wilderness.
That is, the source
material helps the
author discuss important
points about his/her
topic—it is not merely
left as a summary of
Nickens’ article.
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Formatting the MLA Essay

Whether you are writing a research paper or a personal essay, if your instructor requires MLA
style, then you will be expected to format according to the rules found in the MLA Handbook.
The following section summarizes the formatting rules. See the Appendix to this guide for a

sample essay, which illustrates MLA style.

Parentheses containing “MLA” and a section number follow some of the directions listed below
and correspond to the MLA Handbook, Seventh Edition. Please see these sections for further

examples and more detailed directions.

Font and Paper

e Use a standard, easy-to-read 11- or 12-point font such as Calabria, Times New Roman,
Arial or Courier. Use the same font throughout the entire paper (MLA 4.2).

e Use only white 8 %5” x 11” paper of good quality (MLA 4.6).

e Use only one side of the paper (MLA 4.6).

e Instructors who accept handwritten work require neatness, legibility, dark blue or black
ink, and the use of only one side of the paper.

e Always keep both a printed copy and an electronic copy of your paper (MLA 4.0).

Margins
e Leave one-inch margins at the top, bottom and both sides of the paper (you may need

to reset the default margins in your word-processor) (MLA 4.2).

e Align all text to the left. Do not justify the right margins (MLA 4.2).

e Indent the first word of each new paragraph by % inch from the left margin (MLA 4.1).

1%
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Spacing
e Papers must be double-spaced, including quotations, headings, and the Works Cited
page. Single spacing is not used anywhere in an MLA essay (MLA 4.2).
e Do not add additional spacing between your heading and your title, your title and your
first line of text, or between paragraphs (MLA 4.3). NOTE: If you are using Word 2007,
you will need to change settings so that the spacing between lines and paragraphs is

double spaced, not 1.5 spaced.

Heading and Title

e In MLA, you do not need a title page.

e Instead of a title page, begin one inch from the top of the first page on the left side
Your name
Your instructor’s name
The course

Day, month, year (see MLA 4.3).

For example:

Smith 1

Kelly Smith
Dr. Jeanine Jewell
English Composition 1010
12 June 2010
This is the Title: My Essay

e Do not put your essay title in quotation marks, boldface, italicize, put it in all capital
letters, or a different font size (MLA 4.3).
e Do not put a period at the end of the title (MLA 4.3).

20



In your title, capitalize the first word, the last word, and all “principal” words (nouns,
pronouns, verbs, adjectives, adverbs, and subordinating conjunctions). Do not
capitalize articles, prepositions, coordinating conjunctions, or the “to” in infinitives
when they fall in the middle of a title (MLA 4.3).

Follow the rules of capitalization and italicize only the titles of books, magazines,
films—anything you would normally italicize according to MLA style. For example:
Class Issues in Charlotte Bronte’s Jane Eyre. Note that that the 7" Ed. discontinues

the use of underlining and specifies italics. (MLA 4.4).

Headers and Page Numbers

o

In the upper right corner enter your last name and number all pages consecutively

(MLA 4.4).
Do not use a “p.” before the page number. Do not add a period, a hyphen or any

other mark or symbol (MLA 4.4).

See the “Using Microsoft Word 2007” section for detailed instructions on how to

set up the format of your paper.
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MLA Citations

Overview

MLA citations consist of two parts: the in-text citations and the Works Cited page. Together, in-
text citations and the Works Cited page lists the books, journals, interviews, films, and other

sources that you directly quote and cite in your text.

In-text citations (also known as parenthetical citations) are the citations found within your
writing that alert readers that an outside source has been used. In the example below, the in-
text citation (Shelley 114) tells readers that the previous quote was written by Shelly and

appears on page 114 of the work written by Shelly and listed on the Works Cited page.

Example The Creature taught himself to be more than just a creature: "While | improved

#1 in speech, | also learned the science of letters" (Shelley 114).

The Works Cited page is the last page of a paper and lists all the sources for each in-text
citation. The sources listed in the Works Cited page provide much more information that
readers can use to find the source themselves. Listed below is an example of the Works Cited

entry that corresponds to the previous in-text citation:

Example

#2 Shelley, Mary Wollstonecraft. Frankenstein. New York: Penguin, 1994. Print.

There are guidelines and tips to using both in-text citations and the Works Cited page. For more
information, continue reading “Using In-text Citations,” “Writing the Works Cited Page,” and

“How to Create Works Cited Entries.

Why Should | Use Citations?

There are three notable reasons why citations must be used in paper writing. The first reason
has to do with intellectual property. People who think, research, and write for a living are proud
of the work they do, and when they do something original, they consider it intellectual property,

and so does copyright law. For someone to use their ideas, words, or research without giving
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them credit is equal to theft, both ethically and legally. If you don’t give proper credit to

referenced sources, you are guilty of plagiarism.

The second reason for using citations has to do with readers, who often become interested in
references they find in their reading. Upon reading your essay, they may want to know more
about a particular source you used. Therefore, citing your sources is not only the fair and
honest thing to do (in respect to the original authors), but it is also a courtesy to your readers.
When readers come across something in your writing that they want to know more about,
they can use your in-text citation to direct them to the corresponding entry on your Works
Cited page. From there, they will have all the information they need to gain access to the

original source.

The third reason for using citations involves your own credibility, making yours a well
researched essay, worth reading. Citing credible sources shows that you have researched your

topic and are in your own right somewhat of an expert.
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Writing the Works Cited Page

In-text citations can’t, by themselves, tell your readers all the information they may want to
know. That’s where the Works Cited page becomes useful. Every source that you mention
within your essay must be recorded on your Works Cited page, even if you paraphrased it. This
guide offers plenty of information about the Works Cited page, but you may also find it useful to

review section 5 of the MLA Handbook or section 48 of The Everyday Writer.

For readers to use the Works Cited page, the entries must match the source used and cited in
your essay. For example:
According to T. Edward Nickens, visitors to Shenandoah State Park limit their
view of the park to what can be seen from a car (640).
If a reader were to look up this source on the Works Cited page, then he/she would look down
the list of sources (which is alphabetized), and find “Nickens.” Many Web pages do not provide
an author, so use the title in the in-text citation to match the first words of its entry in the Works
Cited page. One of the goals of the MLA style is to make it easy for readers to find information

quickly and efficiently.

Smith 14
Jane Smith Smith 1 Works Cited
Dr. Nielsen FeFalluga, Dino. Guide to Literary and Critical Theory.
English 1010 West Lafayette: Purdue U.P.. 2006. Print
5Jan. 2009

MLA Research Project Hays, Sandra. Lorem Ipsum. New York: Feugait,

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, 2009. Print
sed diam nonummy nibh euismod tincidunt ut laoreet dolore Miller, Sandra, Untold Stories. Madison: U Wisconsin P,
magna aliquam erat volutpat. Ut wisi enim ad minim veniam,

2009. Print.
quis nostrud exerci tation ullamcorper (“Shakespeare’s” 21) 009. Print
accumsan et iusto odio dignissim qui blandit praesent luptatum “Shakespeare’s Mysterious Life..” Newsweek 9 July 2008:
zzril delenit augue duis dolore te feugait nulla facilisi. 19-23. Print.

Duis autem vel eum iriure dolor in hendrerit in vulputate —

Theakl, Fidkal. “Wonderful Title.” Time 4 June 2006.

—

velit esse molestie consequat, vel illum (Hays 32). Dolore eu

consectetuer adipiscing elit, sed diam nonummy nibh euismq‘.—fé

tincidunt. praesent luptatum zzril delenit augue duis dolore te .
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Works Cited: Frequently Asked Questions

In what order should my sources appear?
All sources on the Works Cited page should be listed alphabetically. Use the author’s
last name or the first word of a source to determine which appears first, second, third,
and so on. For example, if the author of one source is “Smith,” then the source should
appear alphabetically by “S.” If your source has no author but a title, then use the first
letter of the title to determine where it should appear. See the Shakespeare example
on the previous page.

Is my Works Cited page a new document?
No. Your Works Cited page is a new page, but not a new document. To create a new
page for your Works Cited, go to “Insert” and select “Break” and then “Page Break” to
begin your Works Cited on a new page.

How do I title my Works Cited page?
At the top of the page you are using for your Works Cited, center your text and type the
words Works Cited in the same font type and size as the rest of your paper. Do not bold,
underline, or place in quotation marks.

How do | create a hanging indent?
See page 35: “Using Microsoft Word 2007 to Format MLA Essays.”

Is my Works Cited page supposed to be double-spaced?
Yes, double-space the entire page. Do not use extra spaces between the heading and
the first entry or between entries.

Do | number the sources on my Works Cited page?

No. List the sources alphabetically.

Organizing Each Source

Each type of source requires slightly different information. For example, books are recorded
differently than online journals, and interviews are noted differently than films. Now that you
have an idea of how to format the Works Cited page, you can move onto what’s included in
each entry and where specific information such as the publisher is placed. Since MLA format is
very particular about structuring citations, things can seem complicated. Don’t be afraid to
consult this guide, the MLA Handbook, The Everyday Writer, your instructor, or the Writing
Center for help. Page 33 contains a sample Works Cited page, which shows how your entries

would look all together.

25



How to Create Works Cited Entries

A few important notes:

The Works Cited page should be a new page in the document, with page

numbers continuing from your main essay.

Center the words Works Cited at the top, do not call it a “bibliography.”

Use the same font as used in your essay. Do not bold “Works Cited.”

The entire page should be double-spaced with no extra lines between entries.

When writing the Works Cited page, list all entries in alphabetical order.

Note the hanging indent in MLA style: That is, the second (+) lines of your entry

are “pushed in” % inch. This makes it easier for the reader to see the first piece

of information in the list. Formatting a hanging indent also makes your editing

easier later.

¢ In the Seventh edition of The MLA, a major change occurs regarding the
listing of Web based sources. (See MLA 5.6.1). Do not include a URL unless
it may be likely that your reader cannot find your source doing a simple
web search. When including the URL, place it after the date of access. If an
address does not fit on one line, break it up at the double or single forward

slashes.

Please Note: The words “Book,” “Interview,” “Pamphlet,” etc, do not appear as a heading on

the actual Works Cited page; they are simply listed here to help you identify which type of

documentation to use. MLA does require you to indicate the medium at the end of each entry.

See below.

Books:

One Author, Book (See MLA 5.5.2):

Last Name, First Name. Title and Subtitle of Book: Italicized. \Where the book was

Note:

published: The Publishing Company, the date of publication. Medium of
publication, such as, Print, Web, Television, Radio, CD, Performance.
Note: The inclusion of media is new in the MLA 7" ed.

MLA now states that there is no longer a choice in underlining or italics.

No underlining is used for titles. (See MLA 3.6.2)

Herrera, Hayden. Frida: A Biography of Frida Kahlo. New York:| 26

Harper, 1983. Print.

B o




Two Authors:
Same style as above, except add “and [second name].”

Note: only reverse the first and last name of the first author.

Mangelsdorf, Kate, and Evelyn Posey. Choices: A Basic Writing

Guide with Readings. New York: Bedford, 2003. Print.

-

Three Authors:

Flachmann, Kim, Jane Maher, and Elizabeth Campbell. Mosaics:

Focusing on Essays. Upper Saddle River: Prentice Hall,

1998. Print.

o

More than Three Authors:

Johnson, Nancy, et al. All About Essays. Lincoln: U of Nebraska P,

2008. Print

-

Cite the first author’s name followed by the phrase “et al,” meaning “and others” in Latin
followed by a period. Note the abbreviation used above for a university press.

Article, Essay, or Chapter in an Anthology or Book with Editor (MLA 5.5.6):

and not the editor’s name. Type “Ed.” for “editor” and always list the page

E Make sure that you list the author of the “part” of the book that you are using,
numbers from which the source came.
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Author’s Last Name, First Name. “Title of story, poem, article, or essay.” Anthology Title.
Edition (if there is one). Ed. Name of Editor (First, Last). Publisher Place: Publisher
Name, Date. Page #-page #. Medium.

Note that in the example, the hundred is dropped from the page numbers. 278 become

s78.

Allison, Dorothy. “Gun Crazy.” The Norton Reader. 10" ed. Ed. Linda
Peterson, John C. Brereton and Joan E. Hartman. New York:

Norton, 2001. 275-78. Print.

-

Interviews (MLA 5.7.7):

Interviews may be published, or you might conduct one yourself. For interviews that you
conduct, indicate the type of interview after the name of the person interviewed. For published
interviews, you will add the title of the interview and the interviewer (if known), other required
elements for the type of source (such as magazines), and the medium such as Radio or CD.

Lindely, Richard. Telephone Interview. 12 May 2008.

Otwell, Steven. Personal Interview. 11 Nov. 2007.

Smith, Michael. Interview by Ted Koppel. Nightline. ABC.
WABC, New York. 12 Jan. 2001. Television.

Tracy, Barbara. Interview. New York Times 26 Feb. 2009,

late ed.: B12. Print.

Pamphlets (5.5.19):

be difficult because much of the information cannot be found. In this example, the place of
publication is unknown, so “n.p.” is used to indicate the unknown place. Only cite page
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numbers in a pamphlet if they are published in the source. Follow the general outline for a
book, building in as much information as you can fill in. Such publications will often have

no author.

Domestic Mistreatment of the Elderly: Towards Prevention. n.p.:

American Association of Retired Persons, 1987. Print

o

Print Periodicals: (MLA 5.4)

E Note that the title of a work inside a journal or magazine is put into quotation marks,
while the name of the journal/magazine is italicized.

Author’s last name, First name. “Title.” Name of Journal/Magazine Volume number. Issue
number (year in parentheses if using volume and issue) OR use date if volume and

issue are not indicted: page numbers. Medium.

Ficaro, Barbara. “Canterbury’s First Dean.” Sixteenth Century Journal
18.3 (1987): 343-46. Print.

Donnelly, Sally B. “Education: Teachers Are Lagging Behind in

Logging On.” Time 27 Sept. 1999: 26. Print.

| e

Online Periodicals (MLA 5.6):

Scholarly Journal: Add medium (web) and date of access. Web addresses are no longer
included.

Author’s last name, First name. “Title.” Name of Journal or Magazine Date published.

Page range only if printed on the screen, otherwise use n. pag. Medium (Web.)

Date of access. Web addresses are no longer used.

Koblitz, Neal. “The Case Against Computers in K— 13 Math Education

(Kindergarten through Calculus).” The Math Intelligencer

Spring 2006. n. pag. Web. 19 Feb. 2010.

- e




Periodical (Full Text) Accessed through Library Database (See MLA 5.6.4)
Author’s last name, First name. “Article Title.” Name of Journal/Magazine VVolume number,
issue number (date in parentheses): page numbers. Title of database. Medium of publication

(Web). Date of access.

III

Tucker, Miriam. “Varicella: Rates are Dropping, But it Still Can Kil

Pediatric News 39.5 (2005): 12-14. Health Reference Center.

Gale. Web. 5 June 2008.

| e

Two (or more) Works by the Same Author

the author’s full name the first time, and alphabetize by the title of the work or
whatever is in the second position. Use three hyphens followed by a period in place of

the author’s name in each entry following the first to indicate that you are using the same
author.

E Many times you will use more than one work by the same author. To do this, only cite

Allison, Dorothy. “Gun Crazy.” The Norton Reader. 10" ed. Ed. Linda
Peterson, John C. Brereton and Joan E. Hartman. New York:
Norton, 2001. 275-78. Print.

---. “Every Book is a Lesbian Book.” Salon. 10 June 1999. n. pag. Web.

5 June 2008.

o
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Professional Website: (see MLA 5.6.2)

For works that are nonperiodical (not published daily, weekly, monthly, etc.) and only available on
the Web, include the following:

e Author, compiler, director, corporate author, or whoever the page gives credit
at the creator/writer. (Note that you might not find this, and you will simply
enter the title first).

o Title of the work, italicized if it stands alone. Put it in quotation marks if it is
part of a large overall site.

e Title of overall web site, if different from item 2.

e Version or edition, if found.

e Publisher or sponsor of site. If not found use n.p.

e Date of publication. If not found, use n.d.

e  Medium (Web).

e Date of your access.

“Advocacy.” ADA. 2005. American Dental Association. 14 Sep. 2005
Web. 18 Nov. 2008.
Grant, Lindsey. “The Wrimo Report.” National Novel Writing Month.
The Office of Letters and Light. 12 Jan. 2010. Web. 18 Jan.
2010.

NAIC Online. 29 Sept. 2003. National Association of Investors.

Lecture or Speech: (See MLA 5.7.11)

Speaker’s Last name, First name. “Title of Speech.” Meeting and sponsoring organization.

Location, City and State. Date. Descriptive label, such as Address, Lecture, Keynote speech,

Reading.
Hathaway, Kris. “Federal Health Care Reform.” American Association of

Dental Consultants. San Diego. 5 May 2010. Featured Speech.




Film or Video Recording (See MLA 5.7.3)

Title of film or video. Dir. Name of Director. Optional to include names of major
actors in film here not in the beginning unless citing the contribution of a that
director or actor, rather than the film itself.. Distribution Company, Year.

Medium (Film or DVD).

Smoke Signals. Dir. Chris Eyre. Perf. Adam Beach and Evan Adams.

Miramax, 1998. DVD.

Note: The following page is an example of a Works Cited
Page and contains all the entries described above as they
would appear on the Works Cited page:
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Using Microsoft Word 2007

to Format MLA Essays

Learning to use a new word processing program can be stressful. Word 2007 has a new “ribbon” system that lays
out all the tools you’ll need under categorized tabs, but all the rearranged icons in this new system can be
intimidating. With a little practice, however, and the use of this step-by-step guide, you will be able to use
Microsoft Word 2007 to format your MLA essay. For those still using Word 2003, handouts are available on the
Writing Center web page and in the Writing Center.
Two notes before you get started:

e The toolbar at the top of the screen is now called the Ribbon. The Ribbon contains

each categorized tab and all the tool icons.

e To save, print, or open a new document, click on the multi-colored Office Button
found in the upper left-hand corner of the screen.

Creating a Header — Method # 1

1. Onthe ribbon, click the Insert tab. Page Layout
; : “ ” ) Cover Page j B lal

2. Click Header in the “Header & Footer” group and ) Biank Page et B &
. . . . _ Table Picture Clip

select the first option in the list, “Blank.” %= Page Break - Art

3. The header will appear at the top of the page. Type

your last name in the area that says _ )
_] __] \' A l 4 Quick Parts ~ 2% Signatute Line ~

“Type Text.” Be sure that the font

— Al wordat -~ 3} Date & Time
Header! Footer Page Text
size and type matches the rest of - Number~ || Box~ "4 Object ~
| Built-in -
your essay. ¥ Brank

4. Right-align the text (see “Aligning

Text” below).

j A 2| Quick Part:
5. Toinsert the page number, click the # Al wordart =
Page Text =
Insert tab. Click Page Number, then “Current Position.” Mumber ~||| Box> = “T9F -4F
[#] | Top of Page 3
H H “" H n H
Select the first option, “Plain Number.” The page number will B Bottom of Page ol
appear after your last name on each page of your paper. ] | Page Margins ’
#]  Current Position 3
r Format Page Mumbers...
ﬂ.\ Bemove Page Mumbers
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Creating a Header — Method # 2

1. Click on the Insert tab. A H P 2l 2l QuickParts = i Signature Line = | TT

A wordart - 3] Date & Time (7]

B B"G

% Hyperlink
Aé- Bookmark

ture Clip Shapes SmartArt Chart Header Footer | Page Tet
2 C||Ck Page Number Art < '# Cross-reference < ~  |Number~!|| Box- 2= DropCap - hgd Object ~
. - Simple «|@ 1opof Page »
. Plain Number 1 @ | Bottom of Page [ S
3. Select Top of Page, then click =l | page wargins '
d ! [#] | Current Position 3
r . . -
the 3" option, “Plain Number Farmat Fage Numses.. ‘
#k | Remove Page Numbers ﬁmlthl
Plain Number 2 | e —

3'”

4. Type your last name before

Plain Number 3

the page number.

Aligning Text

Documentl - Microso

. Page Layout References Mailings Review View
1. Click on the Home tab. : st =

2. Lookinthe “Paragraph”

group for four alignment

symbols.

3. Use the guide below to move text as desired.

Align Text Left

Justify

Center Align Text Right
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How to View the Ruler

Bafargnces Review

Ruler
E ric

Mailings

1. Click on the View tab.

|:| Document Map
[ Thumbnails

2. Inthe “Show/Hide” group, make sure
Zoom  100¢

that there is a check mark next to Ruler.

3. The small icon on the far right of the
ruler can also be used to show and hide

the ruler.

Using the Ruler — What Each Icon Means

Using the ruler to create paragraph indents and hanging indents, rather than using the TAB key, will save you
time and frustration when organizing paragraphs in your essay and indentations in your Works Cited page.
Review the following information about the Ruler, then follow the directions to create indents. Use the guide

below to help identify the actions of each icon on the ruler.

First Line Indent — Hanging Indent — shows Left Indent — click to
click to drag just this where text wraps; click to drag all three markers
marker by itself. drag just this marker by at the same time.

v itself. A I:I

\ Tab Alignment Right Indent Marker

Button
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Creating a Paragraph indent or Hanging Indent — Method # 1

You can, of course, just use tab; however, using the formatting tools saves time in the long run.

1. Before typing your Works Cited, go to the ruler, drag the Hanging Indent button to the

right to start a hanging indent.

2. For MLA, indent paragraphs and hanging indents by % inch.

= .
y= before:

Creating a Paragraph indent or

Hanging Indent — Method # 2

1. Before typing your Works Cited, click on the Page Layout tab.

2. Under the “Paragraph” group, click the little arrow in the lower, right corner to display the

Paragraph Dialogue Box.

3. Under the “Indentation” section, click the box under the “Special” category and choose First

Line or Hanging.

4., Choose “OK” when finished.

Changing the Default Line Spacing

When you open Word 2007, you will notice that your page will have certain default settings that
do not match MLA standards. Some defaults (such as line spacing) can be confusing. Follow the
directions below before you start writing to eliminate the extra spaces created by the default

spacing:

Step#1

Click on the Page Layout tab.

Under the “Paragraph” group, find “Spacing.”

Use the arrows in the box labeled “After” to scroll down to “0 pt.”
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Step # 2

Paragraph
Indents and Spacing | Line and Page Breaks 1. Click onthe Page Layout tab.
General
pignment;  [L=ft v 2. Under the “Paragraph” group, click the little arrow in the
Qutline level: |Body Text v

Special: By:

st ine NS

4. Click OK

Before: 0 pt

Line spacing:

After: 0pt
Dan't add space betweenybarad

Double v

<

gphs of the same style

Tabs... ] [Qefault... ] [ [o]4 ][ Cancel ]

Saving Your Essay as an .RTF File

lower right corner to display the Paragraph Dialogue Box.
3. Under the “Spacing” section, click the box under the

“Line Spacing” category and choose double.

RTF stands for Rich Text Format. RTF is a universal text format that will enable you the ability to

open your essay on any computer with any word processing program. It is also important to

note that saving as RTF ensures that others (such as your

instructor or Smarthinking tutors) will be able to access

your essay, too. When saved correctly, your essay will have

an .RTF extension; for example: essayl.rtf. Follow the

directions below to save your essay as an RTF: I
1. Click on the Office Button, found in the upper left-

hand corner of the screen.

New

7 Open

P

Print

H Save As

f,/f Prepare

2. Click on Save As, a new box will open, then choose
“Other Formats.”
3. Choose where on the computer you want to save

your file, then type in the name you want to give your file.

ad' Seng

7 Publish
o UE

J Close

(T

(@

]

5

Save a copy of the document

5 Find add-ins for other file formats

‘Word Document

Save the document in the default file
format.

Word Template

Save the document as a template that can
be used to format future documents.
Word 97-2003 Document

Save a copy of the document that is fully
compatible with Word 97-2003,

Learn about add-ins to save to other
formats such as PDF or ¥PSs.
Other Formats

Open the Save As dialog box to select from
all possible file types.

2] Word Options lX Exit Word

4. Click the bottom box, Save as Type and choose Rich Text Format from the list.

5. Click OK to finish. ™=

Savein: | e Removable Disk (L)

o Trusted [CDocuments
Templates || Hamemork

(M Reeent | |DRasume
Docurents.

(4 Deskop
oy My
Dodeuments
W
Computer

) My Network
Diices

Flanams:  [gssayt

Save asbVPEt | pich Text Format

v @ X oiE-

Word 57-2003 Template

Single File Web Page

ieb Page, Filtered

Rich Text Farmat
Flain Text

s<
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Changes to The MLA 7" Edition

The seventh edition contains some of the most dramatic changes to occur in

MLA in years. The exciting part is that these changes make writing in MLA style

much easier. The following is a list of changes that you will notice throughout

this document, The Everyday Writer, and, of course, The MLA Handbook for

Writers of Research Papers, Seventh Edition.

All sources will list the type of medium, making it easier for readers to
identify the type of source.

The URL is no longer included in Web sources. URLs change too
frequently and are hard to manage in a Works Cited page. Instead, the
information given in the entry will make it easy for a reader to find the
source using a web search.

Additional guidelines are listed for online sources.

Writers will now use italics rather than choosing between italics and
underlining.

One space after a period is now the standard. However, MLA says using
two is still acceptable.

Search the Internet for “Frequently asked Questions about the MLA

Handbook” to find frequently asked questions for updates or corrections made

to the edition since publication.
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